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Copyright
No part of this document may be reproduced or transmitted in any form or by 
any means, electronic or mechanical, including photocopying and recording, 
for any purpose without the express written consent of Boris FX.

Copyright © Boris FX 2025. All Rights Reserved

July 10, 2025

About Us
Founded in 1995, Boris FX is a leading developer of VFX, compositing, titling, 
video editing, and workflow tools for broadcast, post-production, and film 
professionals. Boris FX products have grown to serve over a million artists 
worldwide. The company’s success lies in its ability to tightly integrate and 
leverage technologies through strong partnerships with Adobe, Apple, Avid, 
Blackmagic Design, Autodesk, FilmLight, Grass Valley, Magix, SGO, and other 
leading developers of video editing software. In 2014, Boris FX acquired 
Imagineer Systems, the Academy Award-winning developer of Mocha planar 
tracking software. In 2016, Boris FX acquired GenArts, the developer of 
Sapphire, the gold standard plug-in package for high-end visual effects. In 
2019, Boris FX acquired the Academy Award-winning Silhouette for advanced 
feature film rotoscoping, painting, and effects.
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 SILHOUETTE 2025.0.2 - 7/10/25

Bug Fixes
3D Scene

Added Pop-Up Notification For Missing Camera In Imported File
A clear error message is now displayed when no camera is detected in the 
imported Alembic or FBX file.

Alembic Importer Didn’t Handle Camera Transforms With An 
Array Size Of 3
The Alembic importer now properly supports camera transforms with an array 
size of 3.

Y-Axis Rendered Incorrectly When Camera Was At Origin
When the camera was positioned at the origin, the Y-axis failed to render 
correctly.

Default Session Format
The default session format when a clip was not selected was changed from 
NTSC D1 720 29.97 (720x486) to HDTV 1080 24 (1920x1080).

DOD and Matte Assist ML - Performance Degradation
Processing was significantly slower when using a DOD node prior to Matte 
Assist ML.

Fusion - Frozen Frame
Fusion would display a frozen frame when the Timeline began at certain start 
frames, such as frame 1000.

Locale-Dependent Project Data Issues
Projects saved in non-English locales--such as German--could experience 
compatibility issues. These can affect node arrangement in the Trees window 
and shape control point positioning.
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Matte Refine ML - Video Matting v1.0 Crash
Selecting the Video Matting v1.0 model could intermittently cause Silhouette to 
crash.

NVIDIA Driver Issue With Version 550 And Later
Silhouette could hang when GPU nodes were applied using NVIDIA drivers 
version 550 or newer.

Scripting - MediaFormat.parts() Crash
Invoking MediaFormat.parts() to query the part list of a multi-part file could 
trigger a crash under certain circumstanses.

SXR File Right View Failure
SXR files would fail to display the right view unless the Stream > Right 
parameter in the Source node was manually set.
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 SILHOUETTE 2025.0.1 - 6/26/25

Bug Fixes
3D Scene

Camera Did Not Appear With Maya Exported Alembic File
The camera did not appear in the 3D Scene node when using an Alembic file 
created in Maya.

Front/Back Views Were Identical
The Front and Back views were identical.

Orbiting Improved
The 3D Scene node now orbits around the distance between the camera and 
the origin, rather than the focal length. Previously, when zoomed out, the old 
method caused the orbit to behave more like a pan—objects in the background 
remained largely unaffected, making the movement feel less like a true orbit. 
The orbit behavior can be controlled by the 3D > Orbit Mode preference.

Views Without An Image Did Not Playback
3D views without an image did not playback. This happened in Quad 
Perspective, Top, Bottom, Left, Right, Front and Back.

Curve Editor - Dragging Points Crashed Silhouette
Dragging points in the Curve Editor caused Silhouette to crash.

Depth Matte ML - No Result When Connected To Matte 
Refine ML At Default RGBA Output Setting

At the default Depth Map ML > RGBA output setting, adding a Matte Refine ML 
node afterwards displayed black instead of a result. However, setting the output 
to Alpha worked as expected.
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 SILHOUETTE 2025 - 5/26/25

Features
New Nodes

3D Scene
The 3D Scene node provides an environment where you can load scenes in 
Alembic or FBX formats. Once loaded, you can select 3D tracks, solve them 
into a plane, and place cards in 3D space. Using the Data output port, you can:

• Use cards to Insert, Match Move and Stabilize in the Transform node

• Unproject images, paint or composite them, and then reproject the results

• Transform Paint strokes with cards

• Import cards and convert them to layers for use in Roto

• Unproject and stabilize directly in the Viewer using cards

• Convert 3D trackers into 2D point trackers

Colorspace
Converts to L*a*b*, XYZ, and YCbCr colorspaces.

Depth Map ML
Depth Map ML analyzes an image and determines how far away each part of 
the scene is. Use the depth map with other depth objects in the Depth node, 
control blur or color correct based on depth in the Depth of Field and Color 
Correct nodes, and create mattes according to a particular depth level.

Frame Fixer ML
Replace damaged frames with newly generated ones to solve issues like photo 
flash artifacts. When Paint is connected to both the main and Data input ports, 
a morph occurs between the painted keyframes.
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Matte Refine ML
Produces a natural edge from a hard matte providing fine detail with semi-
transparency. Great for hair, feathers, fur, or any irregular edge. Use Matte 
Assist ML to automatically create a hard, animated matte and then let Matte 
Refine ML do the rest.

PowerMesh Morph
Morphs between specified frames using Mocha Pro’s powerful sub-planar 
PowerMesh tracking which tracks warped surfaces and organic objects. When 
Mocha Pro’s Data output is connected to the PowerMesh Morph > Data input, 
a morph occurs between either painted keyframes or individual frames from 
two separate inputs based on the generated mesh.

Unproject / Reproject
The Unproject/Reproject node workflow consists of unprojecting motion 
derived from a 3D Scene node (effectively stabilizing the motion), painting or 
compositing on the locked down sequence and then reprojecting back to the 
original motion.

Unproject
Unprojects motion derived from a 3D Scene node which effectively stabilizes 
the motion.

Reproject
Restores the original motion that existed before using the Unproject node.

Mocha Pro 2025
Mocha Pro has been updated from v2024.5 to v2025. New features include 3D 
Camera Solve enhancements, Object Brush, Matte Assist ML, and Vector 
Matte Clips.

For a complete list of features, fixed bugs and changes, see: Release Notes

Sapphire 2025
Sapphire has been updated from v2024.5 to v2025. New features include 
VHSDamage, DissolveLightLeak, new presets, and user interface updates to 
the Preset Browser, Effect Builder, and Flare Designer. 

https://borisfx.com/release-notes/mochapro-2025-release-notes/
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For a complete list of features, fixed bugs and changes, see: Release Notes

Particle Illusion 2025
Particle Illusion has been updated from v2024.5 to v2025. New features include 
copy/paste gradients, Repeat animation option, improved user interface, and 
new 2025 Emitter Library.

For a complete list of features, fixed bugs and changes, see: Release Notes

Compound Nodes
Compound nodes allow you to merge selected nodes into a single combined 
node, with parameters grouped by node for streamlined access within the 
Parameters window, enabling you to view one node while editing another. 
Customization is provided by adding, removing or renaming nodes and 
input/output ports as well as hiding parameters. Additionally, compound nodes 
can be published to a designated node group and are stored in an external 
location for reuse on other systems.

Node Enhancements
Difference Matte
The Highlight Difference controls add a colored overlay to show what is 
different between the two inputs.

Matte Assist ML - Create Mask ML, EZ Mask, Roto Node
Three buttons in the Parameters window add a Mask ML, EZ Mask, or Roto 
node before Matte Assist ML with their Data output connected to the Data input. 
In addition, when the Create Mask ML and EZ Mask Node buttons are selected, 
Reference Frames is automatically set to Keyframes (data port) while the 
Create Roto Node button automatically sets the Mask Source to Roto (data 
port).

Mocha Pro
The Copy Data, Create Roto Node and Create Tracker Node actions are now 
available as buttons in the Parameters window.

https://borisfx.com/release-notes/sapphire-2025-release-notes/
https://borisfx.com/release-notes/particle-illusion-pro-2025-v18-0-0-release-notes/
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Motion Blur ML
Motion Blur has been renamed to Motion Blur ML and Optical Flow ML is now 
built in.

Roto
Brush Reshape Shortcut For Transform Point Mode
Ctrl/Cmd-Alt-drag left/right rotates the selected points left or right in Transform 
Point mode while in the Brush Reshape tool.

Import From Data Port
In all Tracker-based nodes, the I/O > Import From Data Port button imports all 
layers from a Roto or Mocha Pro node, or all cards from a 3D Scene node, and 
converts them into layers in the Object List.

Transform > Insert > Corner-Pin
The Corner-Pin controls now work when doing an insert.

Stability
Added four new generative modes to Stability.

Erase
Removes unwanted objects using the alpha.

Search and Replace
Search and Replace, similar to Inpaint, replaces specified areas with new 
content, but this time with the help of a prompt instead of alpha. Automatically 
segments the searched object and replaces it with the object described in the 
Select Prompt.

Search and Recolor
Search and Recolor, similar to Inpaint, provides the ability to change the color 
of a specific object in an image using a prompt. Automatically segments the 
object and recolors it using the colors requested in the Select Prompt.

Remove Background
Accurately segments the foreground from an image to remove the background.
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Collect Files
File > Collect Files copies the project and media to a new location with the 
media placed inside the project folder.

ML
GPU Memory Usage Improved On Linux
1.5GB of GPU memory is saved on Linux when using Mask ML with Matte 
Assist ML.

Models Load Faster
Most ML models load faster.

ACES 2.0
ACES 2.0 OCIO config files are now bundled with Silhouette and can be 
selected using the Color Management > Default OCIO Config preference.

Preferences
Default OCIO Config
Chooses the default OCIO configuration. Silhouette is the default, but various 
ACES 2.0 config files can be selected.

Motion Blur
Roto and Shape group Motion Blur preferences were added to determine the 
default motion blur enable state of the Roto node and shapes. 

• Roto > Motion Blur on/off

• Shape > Motion Blur on/off

Shape > Color Mode
Auto
Shape colors are assigned based on the Color > Object Colors preference. 
Each new shape’s color rotates between the 16 predefined Object Colors.

Manual
Shape color is set based on the Color > Default Outline Color preference. 
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Shape > Create Layers In Active Layer
Layers are created within the active layer rather than the root.

Tracker > Track Subtracted Layers
Sets the default state of Track Subtracted Layers.

Scripting
Added "no_ reset" Capability To Property
User-defined properties can now have a "no_reset" flag set such that when the 
Reset All button is pressed in the UI, they won’t be reset to their default value. 
Useful for private hidden opaque properties that should have persistent state.

Added State To All Objects
Previously, only Nodes had user-defined state. Now, you can now attach 
opaque data to all objects without using properties.

Allow Projects To Be Created In startupComplete Hook
Silhouette now handles a project being created during startupComplete.

Made Data Types And Data Type Lists Just Be Strings
Previously data-types were hard-coded as link-time string pointers. Now, they 
are “soft” (ie. simple strings) so they can be created and used in Python scripts.

SFX_NATIVE_IMPORT_DIALOG Environment Variable
Setting the SFX_NATIVE_IMPORT_DIALOG environment variable to a value 
of 1 always uses the native OS file import dialog.

User Interface
AI/ML Node Group
A new AI/ML node group was added and includes: Denoise ML, Depth Map ML, 
Edge Refine ML, Frame Fixer ML, Mask ML, Matte Assist ML, Motion Blur ML, 
Optical Flow ML, Stability, and UpRes ML.

Cache Window - Image Display
Double-clicking an entry in the Cache > Object List displays the image.
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Ctrl+L To Lock Selected Objects
Ctrl/Cmd+L and Actions > Edit > Toggle Object Lock locks selected shapes, 
layers and trackers.

Grids & Masks
The previous Show Format Mask icon has been renamed to Grids & Masks. 
When selected, the Grids & Masks toolbar opens where you can configure and 
display grid and mask overlays.

Matte Assist ML Session Template
Automatically adds Mask ML, Matte Assist ML, and Output nodes to the source 
and selects the Composite workspace. When using the plug-in, the Render 
parameter is automatically set to Output: Cutout.

Node Actions - Reset All
Added an Options icon for all nodes to the right of Obey Matte that includes 
Reset Parameters. Depending on the node, other node actions can be 
performed through this menu.

Node Input/Output Port Connection Indicators
When hovering over a node line connection, the associated input and output 
ports, as well as the connected nodes, are highlighted.

Show Library Versions In About Box
The version information for all libraries (such as OCIO, EXR, etc) that 
Silhouette uses appear in the About Box.

Use Current Frame
A Use Current Frame button (F) was added next to the Frame field parameters 
to automatically enter the current frame.
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Viewer Stabilization
Toolbar
Clicking the Stabilize icon opens the Stabilize toolbar where you can enable 
stabilization, select a transform source or optionally unproject. 

Unproject
Unproject remaps the area inside the layer or card so that it becomes flat--
making it easier to work with pixels that have a regular repeating pattern or tend 
to be more horizontal or vertical.

Utilizes Cards
Cards from the 3D Scene node are available to stabilize the Viewer.

Changes
Shape Motion Blur Enable State

In Silhouette 2024.5 and earlier, new shapes had motion blur enabled if the 
Roto node motion blur state was enabled. Now in 2025 and later, the motion 
blur enable state is controlled by the Roto and Shape > Motion Blur 
preferences.

User Interface
Activate Pasted Node
When coping and pasting a single node, the pasted node is now activated.

Add Dock Icon Moved To Title Bar
The Add Dock icon was moved to the top left of the title bar.
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Bug Fixes
Auto Paint Jitter With Stabilize Enabled

With Viewer > Stabilize enabled when Auto Painting with Match Move, the 
Viewer jittered.

Dot Node Cleared Transform Node Layer Selection
If a Dot node was added to an existing data port connection connected to the 
Transform node, the Transform layer selection was cleared.

File Browser > Open Native Dialog Button (Linux)
On Linux, the File Browser > Open Native Dialog button and User Interface > 
Use Native File Dialog For Importing Media preference did not work.

Inpaint Data Port Was Not On Far Right
The Inpaint data port was in the middle instead of on the far right of the node.

Matte Assist
An Improper Matte Was Created When Interrupted
If the Matte Assist processing was interrupted, for instance with a frame 
change, the resulting matte was incorrect.

Transform Node Corrupted Alpha
Repositioning the image with a Transform node corrupted the Matte Assist 
alpha.

Painting While Auto Painting Caused A Crash
Painting a stroke during auto painting caused a crash.

PNG/TIFF Rendering Was Slower Than Other Formats
Rendering to PNG or TIFF was much slower than other formats because of 
their default compression settings.

Python Library Missing On Linux
The Python libssl.1.1.1 library was missing on Linux.
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Transform Edge Output Premultiplied
The Transform node outputted premultiplied image edges which required 
downstream Composite nodes to have Unpremultiply enabled. To retain 
backward compatibility, only v2025 and later Transform nodes fix this issue.

Known Issues / Limitations
GStreamer

ProRes
All ProRes movies are imported as 16-bpc. This is a limitation of the GStreamer 
ProRes decoder.

Rendering Interlaced Footage
Rendering interlaced footage is not supported at this time.

OpenColorIO - Particle Illusion and Flare Editor
OpenColorIO is not implemented in Particle Illusion or the Lens Flare > Flare 
Editor which results in the image in those interfaces not exactly matching the 
Silhouette viewer.

PowerMesh Warp
The PowerMesh Warp node renders a slightly different result than Mocha Pro.

Silhouette Plug-in
Flame
Upstream Node Changes Don’t Update Until Silhouette Is Opened
Upstream node changes in Flame don’t update when viewing the Silhouette 
plug-in unless Purge Cache is selected, the Render menu is toggled or 
Silhouette is opened.

Sequence Numbering
Flame is not obeying the OFX parameter that determines the start frame, so a 
Flame sequence starting at 1 instead starts at 0 in Silhouette.
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Multiple Instances of Silhouette Plug-in
You can’t connect two Silhouette plug-ins in a row. There can be multiple 
Silhouette plug-ins, just not chained together.

Premiere Pro > Alpha Channels With Soft Edges
By default, Premiere Pro is linearizing the alpha channels exported from the 
Silhouette plug-in even though they are already linear. This causes the alpha 
to appear smaller when using soft edges. To avoid this issue, disable 
Composite in Linear Color in the Premiere sequence settings.

Resolve > Multiple Inputs
Resolve does not allow more than one input for plug-ins that use custom user 
interfaces. However, additional sources can be added directly within Silhouette.
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